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CUSTOMER
© Copyright 2014 SAP AG. SAP NetWeaver 7.4 incl. SR1

2

All rights reserved.

Document History


http://service.sap.com/instguides

Content

1 Getting Started . ...... ... i i it s e 5
11 About this Document . .. . .. 5
12 GlOSSarY . o 5
1.3 SAP NetWeaver Use Cases . . . . ..t 8
1.4 Business View of the Use Cases . . . . . ..ot 10
15 Mapping of Use Cases to Installable Software Units . . ... ... ... . ... .. . . . . ... . .. . ... ...... 11
1.6 Enhancement Packages . .. .. . . . 14
Enhancement Package Concept . .. .. .. 14
Key Facts About Enhancement Packages . .. ... ... .. .. . . . . . 16
2 Planning SAP NetWeaver 7.4 . ... ... .. ...t ittt it te e anaasananannnsanannnns 18
2.1 Major Planning Steps and Related Documentation ... ... . ... .. ... . ... ... ... . ... ... .. ... 18
2.2 Planning the Use Cases and their System Landscapes ... ... ... .. . . . .. .. . . . . ... ...... 19
Building Composite Applications . . ... ... 20
Building Integration Scenarios . ... ... 25
DataWarehousing . . . . . .. 32
Mobilizing Business Processes . . . . . .. . . 34
Integrating and Self-Servicing Content with SAP NetWeaver Portal .. ... ... ... ... ... .. ... 35
SAP Knowledge Warehouse . . ... ... . 36
Custom Application Development (ABAP) . . . . . 37
3 Implementing SAP NetWeaver 7.4 . ... ... ... ittt i s e annnnnnns 41
3.1 Installation Procedure . . . .. . . 41
32 Installation TOOl . . . .. 47
3.3 Configuration of Systems and Follow-Up Activities . .. ... ... ... ... . .. . .. . .. . . . ... ... ... 47
3.4 System Copy and Migration . ... ... ... 48
A Y o o =T 5 o 50
Al Additional Information for Implementing SAP NetWeaver .. ... .. ... ... ... .. ... ... ... ... 50
A2 Description of Software Units . . . .. .. 51
Systems with Usage Types . . .. . ... . 51
Optional Standalone Units . . ... ... . 63
Standalone Engines . . . . . 65
Clients . .o 66
A3 Compatibility Usage Types . . . . .o 69
CUSTOMER
SAP NetWeaver 7.4 incl. SR1 © Copyright 2014 SAP AG.
Content All rights reserved. 3



4

CUSTOMER
© Copyright 2014 SAP AG.
All rights reserved.

SAP NetWeaver 7.4 incl. SR1



1 Getting Started

11 About this Document

This Master Guide is the central starting point for the technical implementation of SAP NetWeaver 7.4 including
Support Release 1 (SR1). It provides you with information about the use cases as well as the installable software
units, and refers you to the detailed documentation (such as the Installation Guides).

Caution

The Master Guide is regularly updated on SAP Service Marketplace. Make sure that you have the latest version
by checking SAP Service Marketplace at [F service.sap.com/installnw74 Jimmediately before starting the
installation.

1 Note

If you install SAP NetWeaver 7.4 with Support Release 1, you install automatically the previously available
support packages 1to 5 at once, and your system goes immediately to 7.4 SP5 without needing to implement
the intervening SPs separately.

Constraints

The scenarios that are presented here serve as examples of how you can use SAP software in your company. The
scenarios are intended only as models and do not necessarily run the way they are described here in your
customer-specific system landscape. Check your requirements and systems to determine whether these
scenarios can be used productively at your site. Furthermore, we recommend that you test these scenarios
thoroughly in your test systems to ensure that they are complete and free of errors before going live.

1.2 Glossary

Short overview of some technical terms as well as SAP NetWeaver key terms:

Table 2

Client Clients are additional installable programs or tools. They reside either on local front-end PCs
accessed by users or on back-end systems where they act as client programs within an SAP
NetWeaver system landscape.

Functional Unit A configured and activated unit of SAP NetWeaver that provides a set of functions, allowing
the implementation and execution of activities such as process steps within IT scenarios. It
is nestable and can be grouped into larger functional units. Examples include transport
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management system, system landscape directory, adapter framework, and business
process engine.

Landscape Pattern

Defines if a technical system is used by one or several product systems to calculate update
and upgrade methods. The landscape pattern can be defined as “hub” system (if used by
several product systems) or as “sidecar” system (if used by one product system).

LMDB

Landscape Management Database

Central storage and editor for system information in SAP Solution Manager, supplied by a
central SLD. In the LMDB, you manage technical information (such as technical systems and
hosts) and logical information (such as product systems and technical scenarios). This data
is the basis for other applications, like monitoring and alerting, diagnostics, maintenance
transactions, and SAP Support Portal.

As of SAP Solution Manager 7.1, the LMDB replaces the previous information storage SMSY.

Logical Component

Group of technical systems that provide a concrete business function by installed product
instances and by different roles (such as development, test or production system).

Maintenance Optimizer
(MOpz)

Application within SAP Solution Manager that guides you through planning and downloading
stack XML files for enhancement packages, support packages, and additional update
packages. These files can be used as input files for the installation by update tools like
Software Update Manager.

Product

An SAP offering in the SAP price list that performs business tasks.

The complete product model is shipped as SAP Software Catalog. The availability of
products is published in the Product Availability Matrix (PAM). The product model defines
the product structure with its product instances, software components, version, and
technical dependencies between product and its components. Products typically have a
name starting with 'SAP..." and are characterized by a version period and a maintenance
cycle. A product can be installed on one or more technical systems. All technical systems
that are involved form the product system.

Examples for products are SAP ERP, SAP NetWeaver, and SAP Solution Manager.

Product Instance

Part of a product version that bundles one or more software components.

A product instance is part of only one product version. It must be installed and updated as a
whole on a single technical system. (ABAP-Java dual-stacks are considered one technical
system.) Patches can still be installed for individual software components. A product
instance can contain other product instances. It can be re-used across products.

Examples for product instances are SAP ECC Server and SAP NetWeaver AS ABAP.

Product System

A group of technical systems on which a product version is installed. Product system
descriptions are used to maintain and plan products in the system landscape.

Product Version

A release of an SAP product.

It bundles product instances and the included software component versions that are
available at a particular time for a specific scope of functionality. Like products, product
versions are shipped in the SAP Software Catalog. They are the basis for the compatibility of

closely coupled systems and the maintenance of product systems.

An example is SAP ERP 6.0, which is a product version of the product SAP ERP.
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Optional Standalone Units

Optional standalone units are additional software units that you install separately. They are
based on Application Server Java (AS Java) and provide specific (server) functions in
combination with one or more SAP systems.

SLD

System Landscape Directory

Central provider of information on technical systems, for consumers in the system
landscape and for external consumers. The SLD gets its information mainly from SLD data
suppliers, which are installed on the technical systems, and from the SAP software catalog.

With the SLD, you collect and edit system data that is required for system landscape
management. This information can be used by other consumers, such as SAP NetWeaver
Process Integration, WebDynpro for Java, and SAP Solution Manager.

SMSY

The SAP Solution Manager System Landscape collects information about the SAP systems
in the landscape. (SMSY is the name of the transaction in SAP Solution Manager.) As of SAP
Solution Manager 7.1, the new information storage LMDB replaces SMSY.

Software Component

Delivery and product unit of an SAP software product

A software component comprises a set of packages that are delivered in a single unit. You
always assign repository objects to a software component by assigning the package
containing these objects. This makes it possible to move repository objects from one
software component to another during a release upgrade. A software component is released
in successive releases with new functions. You can import patches into each software
component separately.

Software Provisioning
Manager

A tool that performs software provisioning processes such as installation, uninstallation,
system copy, or system transformation. The Software Provisioning Manager is delivered
with the Software Logistics Toolset.

Stack configuration file

The stack configuration file is created by the Maintenance Optimizer and is system-specific.
Depending on the software components that are installed in a system, the Maintenance
Optimizer calculates the required software components that have to be updated to reach a
certain target configuration.

Standalone Engine

Standalone engines of SAP NetWeaver are additional installable software units. They do not
work as full-blown systems of SAP NetWeaver, but as standalone engines that provide a
specific (server) function in combination with one or more SAP NetWeaver systems.
Standalone engines are not part of a usage type. They do not run on AS ABAP or AS Java.

SUM

Software Update Manager

A software logistics tool that controls different kinds of implementation processes, such as
upgrading SAP systems, installing enhancement packages, or applying Support Package
stacks.

Support Release

Release offered after the beginning of the unrestricted shipment phase if required and that
contains a collection of all previously available support packages.

Target system

The SAP system on which you are going to install the enhancement package.

Technical Usage

Grouping of software components and contents of SAP enhancement packages that need to
be installed together so that a particular business function can be activated.

SAP NetWeaver 7.4 incl. SR1
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Technical System

Describes a part of a product's software that is installed on one or several physical or virtual
hosts.

A technical system is installed and administered as a whole. It is identified by a system ID
(SID) or extended SID, a host, and an installation number. There are different technical
system types, for example Application Server (AS) ABAP, AS Java, or TREX. Technical
systems are central elements when it comes to software component deployment and
operational activities, such as monitoring and alerting.

Update

Activities to maintain or enhance a system, such as installing enhancement packages,
installing add-ons, or applying Support Package stacks or Support Packages.

Note: The tool for system maintenance tasks is the Software Update Manager (SUM). In the
SUM guide, the term "Update" is used as collective term for all the tasks that can be
performed using this tool (such as performing release upgrades, installing enhancement
packages, or updating a system with Support Package Stacks).

Upgrade

The switch from an older software version to a new version. Typically, both the server
component of a system landscape and other components are upgraded. Several different
technical upgrade procedures are used to upgrade the server component, such as the
Repository Switch upgrade or the System Switch upgrade.

Usage Type

An installed and correspondingly configured part of an SAP NetWeaver system that provides
key capabilities for a system landscape. It specifies the intended purpose of a system, and it
is the result of the configuration of the underlying installed software units and the
configuration of the underlying functional units.

Examples include business intelligence, process integration, and enterprise portal.

Use Case

A definition of use from the end users' perspective for accomplishing a specific goal within a
system. Use cases represent the main capabilities of the system to fulfill specific
requirements.

1.3 SAP NetWeaver Use Cases

The use cases illustrate how you can use your SAP NetWeaver implementation. The main use cases of SAP
NetWeaver and their corresponding key areas of SAP NetWeaver are as follows:

Table 3

Building Composite Applications SAP NetWeaver Composition Environment

Data Warehousing

SAP NetWeaver Business Warehouse

Building Integration Scenarios

SAP NetWeaver Process Integration

Portal

Integrating and Self Servicing Content with SAP NetWeaver | SAP NetWeaver Portal

Mobilizing Business Processes

SAP NetWeaver Mobile
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Custom Application Development (ABAP) (All areas that allow ABAP development on the Application

Server ABAP)

Constraints

As of SAP enhancement package 1 for NetWeaver 7.3, SAP NetWeaver Mobile is only available as add-on to SAP
NetWeaver. For more information see SAP Note 1645275.

More Information

You can get all information about the key areas with regard to SAP NetWeaver 7.4 in the SAP Help Portal and in
the SAP Community Network (SCN):

® SAP Help Portal

SAP Help Portal bundles access to SAP product documentation and also related information, such as SAP
Notes, product availability information, as well as community content.

For SAP NetWeaver 7.4, you access the Help Portal using the address [F help.sap.com/nw74 3.
1. Choose|r Application Help » <key area> 1 for instructions for using the application.

2. Choose|r Application Help » Function-Oriented View » <key area> A for a component-based reference of
all functions and tasks that can be performed with the product.

e SAP Community Network (SCN)

The SCN is organized into more than 300 “spaces”, which support small, self-contained communities. These
communities are typically focused around a topic, an SAP product, or an industry. Each space contains a
complete set of social networking tools including a discussion forum, a blogging area, and an area where you
can publish and collaborate on documents.

As a logged-on member, you can go to any space in the SCN landscape but it’s likely that you will be
interested in visiting and following a particular set of spaces that reflect your particular range of interests and
where members who share your interests are likely to hang out.

SCN spaces are where you get the latest news from SAP and the community, where you interact with your
peers, where you earn points for your contributions, and where you establish reputation as being expert on
certain topics

You access the SCN using the address [» scn.sap.com 3.
1. Tolearn more about SAP NetWeaver, choose:

o |» Products » tab “Technology” » Application Foundation/Integration » SAP NetWeaver » SAP
NetWeaver 3 or

o |» Lines of Business y Information Technology » SAP NetWeaver 1
© |r scn.sap.com/community/netweaver 3

2. Moreover, the SAP Community Network provides you with detailed information regarding the SAP
NetWeaver use cases:

CUSTOMER
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Table 4

Integrating and Self Servicing Content with SAP NetWeaver | |r Products # tab “Technology” » Application Foundation/
Portal Integration » SAP NetWeaver » Team Productivity » SAP
NetWeaver Portal 3

or choose scn.sap.com/community/netweaver-portal

Data Warehousing |F Products » tab “Technology” » Application Foundation/
Integration » SAP NetWeaver » Information Management »
SAP NetWeaver Business Warehouse 3

or choose scn.sap.com/community/data-warehousing/
netweaver-bw

Building Composite Applications |F Products » tab “Technology” » Application Foundation/
Integration » SAP NetWeaver » Process Orchestration »
Business Process Management and Composition 3

or choose scn.sap.com/community/bpm

Custom Application Development b Products » tab “Technology” » Application Foundation/
Integration » Custom Development » ABAP Development »
ABAP Development 3

or choose scn.sap.com/community/abap

Mobilizing Business Processes |F Products » tab “Technology” » Enterprise Mobility » SAP
NetWeaver Mobile 3

or choose scn.sap.com/community/mobile/netweaver

Building Integration Scenarios |» Products ¥ tab “Technology” » Application Foundation/
Integration » SAP NetWeaver » Process Integration »
Process Integration 3

or choose scn.sap.com/community/process-orchestration

1.4 Business View of the Use Cases

For implementation and configuration purposes, the SAP NetWeaver use cases are structured according to the
business view of SAP's Software Portfolio. This portfolio is structured using elements such as

e Solutions

® Solution Editions

e Key Capabilities / Scenario Groups
® Scenarios / Processes

Various tools, services and processes use the business view of the SAP Software Portfolio, among them the
Scenario & Process Component List in the SAP Service Marketplace (¢ service.sap.com/scl 3) or the Business
Process Repository for the SAP Solution Manager.

The following table displays the structured business view of the use cases in the SAP Solution Manager:
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Table 5

Use Case

Corresponds to Business Scenario

Group/Key Capability

Includes the Scenarios/Processes

Building Composite Applications

Building Composite Applications

®  Business Rules Management

®  Java Development and SOA
Infrastructure

®  Process Composition

Data Warehousing

Enterprise Data Warehousing

®  Data Modelling

® Define Data Flow

® Metadata Management

®  Performance Optimization

®  Scheduling and Monitoring

Building Integration Scenarios

Building Integration Scenarios

Building Integration Scenarios

Building integration-centric processes

Building integration-centric processes
using the single-SID Pl and BPM
solution

Integrating and Self Servicing Content
with SAP NetWeaver Portal

Integrating and Self Servicing Content
with SAP NetWeaver

e Building Communities with Wikis &
Forums

®  Content Management Scenarios
with Knowledge Management

® Managing and mashing up portal
pages with Web Page Composer

®  Portal Landscape Interoperability
and Openness

®  Unified Access to Applications and
Processes

Mobilizing Business Processes

Mobilizing Business Processes

® Developing Mobile Applications for
Occasional Connection

®  Enabling Mobile Applications for
Occasional Connection*

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

Custom Application Development
(ABAP)

Application Lifecycle Management

Application Lifecycle Management

1.5 Mapping of Use Cases to Installable Software Units

To give you a quick overview of SAP NetWeaver 7.4, the table below shows the mapping between use cases and
required SAP NetWeaver software units.

For details about the software units, see section Description of Software Units [page 51].
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Table 6

Use Case

Usage Types (Functional Units)

Standalone

Engines

Standalone Units

Clients

Building Composite
Applications:

[page 20]

Business Rules
Management and
Process Composition

e AS Java

®  Adobe Document Services
(optional)

® Business Process
Management and Business
Rule Management

®  Composite Application
Framework

®  Composition Environment
Platform

e NW Product Description
® Dl[optional]

SAP
NetWeaver
Developer
Studio

Visual
Composer

Adobe
LiveCycle
Designer
(Optional)

Web Browser

Building Composite
Applications:

[page 20]

Java Development and
SOA Infrastructure

e ASJava
e NW Product Description
® DI [optional]

® Enterprise Services

SAP
NetWeaver
Developer
Studio

Web Browser

Repository
Data e AS ABAP Search and SAP GUI with
Warehousing e BWABAP Classification Business
[page 32] o AS Java (TREX) Explorer (Bl
Add-On)
®  NW Product Description
[optional] SAE )
BusinessObje
e AS Java Extensions cts Analysis,
[optional] Edition for
e Bl Java [optional] Microsoft
e EP Core - Application Office*
Portal [optional] [optional]
e  Enterprise Portal [optional] SAP
BusinessObje
cts Crystal
Reports*
[optional]
SAP
BusinessObje
cts
Dashboards
[optional]
SAP
BusinessObje
cts Web
CUSTOMER
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Use Case Usage Types (Functional Units) | Standalone Optional Clients
Engines Standalone Units
Intelligence*
[optional]
e SAP
BusinessObje
cts Design
Studio*
[optional]
Building Integration ®  Application Server Java e Adapter Advanced
Scenarios [page 26] e NW Product Description Engine (Java Adapter
SE tional Engi
® AS Java Extensions ) [optional] ng|.ne
[optional]
®  Application Server ABAP
Advanced
®  Process Integration Adapter
® Enterprise Services Engine
Repository Extended
®  Process Integration
Adapter Engine
Integrating and Self ® AS Java
Servicing Contentwith | o NW Product Description
AP NetW
S erieaver ® AS Java Extensions
Portal [page 35]
® EP Core — Application
Portal
e EP
e  Portal Add-on (for Building
Communities with Wikis
and Forums only)
Mobilizing Business e AS ABAP e SAPGUI
Processes: [page 34] e Mobile e SAP
Developing Mobile e Application Server Java NetWeaver
AppIICétions for e DI Developer
Occasional o Studio
Connectivity ® EP Core — Application ' '
Portal [optional] ®  Mobile Client
Mobilizing Business e ASABAP e SAPGUI
Processes: [page 34] e Mobile o SAP
Enabling Mobile e Application Server Java NetWeaver
Applic(_ations for e DI Developer
Occasional o Studio
Connectivity ® EP Core — Application ' '
Portal [optional] ®  Mobile Client
CUSTOMER
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Use Case Usage Types (Functional Units) | Standalone Optional Clients
Engines Standalone Units

Custom Application e AS ABAP SAP GUI
Development ABAP
[page 37] Development
Tools
(Eclipse)
SAP Knowledge e AS ABAP Search and Web Browser
Warehouse [page 36] e ASJava Classification SAP GUI (KW
(TREX) Add-on
Content included)
Server

*Note that SAP BusinessObjects products require separate licenses.

1.6 Enhancement Packages

1.6.1 Enhancement Package Concept

We have adapted our major release strategy to better fit your adoption cycle. To ensure that you benefit from new
developments and innovations while minimizing the impact on your core operational systems, SAP uses
enhancement packages to speed up the delivery of new functions.

With SAP enhancement packages, you can install and activate new functions depending on your business needs
without having to perform a system upgrade.

You can selectively implement the new functions and activate the software upon business demand. As a result,
you can isolate the impact of software updates and make new functions available faster due to shortened test
cycles.

Implementation

There are three different scenarios to implement an enhancement package:
® |nstallation of an enhancement package on an existing SAP system
® New installation of an SAP system including an enhancement package

® Upgrade of an SAP system including an enhancement package

Maintenance

SAP enhancement packages have Support Packages of their own that are equivalent to the Support Package
versions of the underlying SAP system. We highly recommend installing the enhancement package in
combination with the latest available Support Package stack. This approach reduces installation, modification
adjustment, and testing effort. Using this strategy, you can install SAP enhancement packages as a normal
maintenance activity together with Support Package stacks.

An enhancement package requires a specific Support Package stack level in the source release SAP system.

CUSTOMER
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1 Note

If the SAP system is on a lower Support Package stack level, all relevant Support Package stacks for the
enhancement package installation are automatically included into the download queue by the Maintenance
Optimizer, as well as the latest available Support Packages for the enhancement package.

For a better understanding of the general concepts and principles of updating a system, see the Maintenance
Planning Guide at | service.sap.com/mopz » section “How-To's and Guides" 3

Tools

The enhancement package installation requires the following tools:
1. SAP Solution Manager

1 Note

Use of SAP Solution Manager is mandatory.

Tool versions:

You require at least one of the following versions of SAP Solution Manager.
o SAP Solution Manager 7.0 EHP1, SP23 or higher

©  SAP Solution Manager 7.1, SPO1 or higher

SAP Solution Manager 7.0 EHP1, SP23 supports all update and maintenance processes (for example,

transaction SMSY or Maintenance Optimizer). Thereis no need to upgrade to SAP Solution Manager 7.1.

For more information, see SAP Service Marketplace at |p service.sap.com/solutionmanager 1.

System Landscape Maintenance with SAP Solution Manager:

Make sure that you have correctly defined and maintained your system landscape in SAP Solution Manager:

o SAP Solution Manager 7.0: Use the SAP Solution Manager System Landscape (transaction sMsy) for the

complete system description.

©  SAP Solution Manager 7.1 SPO1 to SP04, use the Landscape Management Database (transaction LMDB)

to maintain technical system information. For logical product system information, use transaction smMsy.

o SAP Solution Manager 7.1 SPO5 and higher, use the Landscape Management Database (transaction
LMDB) for the complete system description. (The transaction sMSY is no longer required.)

For more information about the Landscape Management Database (LMDB), see [k help.sap.com/

solutionmanager?1 » Application Help » SAP Library SAP Solution Manager 7.1 <SP version> » SAP Solution

Manager Operations » Managing System Landscape Information 1.

Landscape Verification with SAP Solution Manager:

To verify and correct your system landscape, SAP highly recommends that you use the verification functions

of the SAP Solution Manager:

= Recommendation

Before installing the enhancement package, we recommend that you run a landscape verification to check

your landscape setup and your system descriptions, and to correct data if necessary.

o SAP Solution Manager 7.0 to 7.1 SPO4: Use Landscape Verification 1.0 for SAP Solution Manager. This
add-on allows you to identify and correct issues in your SAP Solution Manager landscape (transaction

SMSY) before they cause problems, for example during a system update. Examples for errors are a
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missing connection to the System Landscape Directory or the wrong assignment of products to
technical systems. For each type of error, a generic description for the solution is provided.

o SAP Solution Manager 7.1 SPO5 or higher: Use the landscape verification function that is embedded into
the product system editor of the Landscape Management Database (LMDB). It replaces the previous
Landscape Verification tool.

For more information about the landscape verification, see the SAP Community Network at|p scn.sap.com/
docs/DOC-8793 1.

2. Installation or upgrade tools (depending on your scenario)
o SAP Solution Manager Maintenance Optimizer (MOpz)

The SAP Solution Manager Maintenance Optimizer (MOpz) (accessible from the Change Management
work center) supports the download of a consistent queue that includes all necessary Support Packages
and enhancement packages. In addition, SAP Solution Manager calculates a valid import queue for the
selected SAP system and generates the enhancement package stack configuration file that you require
for the installation.

o Software Provisioning Manager 1.0

For the new installation of an SAP system including an enhancement package you use the standard
installation tool software provisioning manager 1.0.

o Software Update Manager (SUM)

To install an enhancement package on an existing SAP system, as well as for the upgrade of an SAP
system to a higher release including an enhancement package, you use the Software Update Manager
(SUM).

1.6.2 Key Facts About Enhancement Packages

The following list summarizes important facts about the enhancement package concept and recommended
approaches:

® |nstall only selected parts of the enhancement package. The selection is driven by the functional need from a
business point of view.

® You cannot mix the installation of different enhancement package versions in your ABAP-based SAP system.
You can have just one enhancement package version in the SAP system. This means, if you have already
updated technical usages to a previous EHP you need to apply the current EHP to those components as well.

e SAP enhancement packages are cumulative, meaning that each new enhancement package includes new
innovations of its own as well as all innovations delivered with prior packages.

® \Werecommend installing the latest available enhancement package version.

® |nstall enhancement packages and Support Packages in one single step (this includes the preconditioned
Support Packages).

e SAP enhancement packages have Support Packages of their own that are equivalent to the Support Package
versions of the underlying SAP system.

e SAP enhancement packages have the same maintenance period as the underlying core application.
® Theinstallation of an enhancement package is irreversible.

® Aslong as you do not activate a business function, the installation of an enhancement package has no impact
on existing business processes or user interfaces.

You can only activate business functions in ABAP-based systems, not in Java-based SAP systems.
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® The activation of most business functions and extension sets is irreversible. Only a small number of business
functions is reversible.

Test the installation process and activation of new functions in advance on a sandbox system. Ensure that
you evaluate the runtime and the SAP system behavior, its dependencies and impacts. Make sure that your
SAP system is free of errors before going live.
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2 Planning SAP NetWeaver 7.4

The general sequence for the implementation of an SAP NetWeaver system is as follows:

1. You plan the implementation (such as scope, hardware and software requirements, release restrictions).

2. You plan the system landscape for the use cases.

3. Youinstall the components of your SAP NetWeaver system.

4. You configure your systems.

In the following, you find information about the planning steps for SAP NetWeaver 7.4.

® Major Planning Steps and Related Documentation [page 18]

® Planning the Uses Cases and their System Landscapes [page 19]

2.1 Major Planning Steps and Related Documentation

During an implementation project, you have to take into account many aspects and to take various decisions. The
major planning steps of this process are outlined below.

Table 7

Step Description Further Information

Scope and Requirements

You determine the scope of your SAP
NetWeaver implementation.

For more information, see SAP NetWeaver
Use Cases [page 8].

Installable Software Units

You determine which installable software
units (that is, systems with usage types,
standalone engines, optional standalone
units and clients) are required for the use
cases.

For more information, see the Mapping of
Use Cases to Installable Software
Units [page 11] section.

For details about the software units, see
Description of Software Units [page 51].

Landscape Planning

You determine the system landscape and
consider the landscape-relevant aspects
concerning your required use case.

See Planning the Uses Cases and their
System Landscapes [page 19].

Hardware & Software
Prerequisites

Use the Product Availability Matrix (PAM) to
check which platforms (operating systems,
databases, browsers) are supported for
your SAP NetWeaver components.

service.sap.com/pam

Check which hardware sizing is required for
your SAP NetWeaver release.

service.sap.com/sizing

Release Restrictions

Check SAP Notes for any release
restrictions.

®  Regarding SAP NetWeaver 7.4, see
SAP Note 1730102.
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_ Step Description Further Information

Solution Manager Prerequisites

You need at least SAP Solution Manager 7.0
with support package level 23.

Make sure that your SAP Solution Manager
system has the required support package
level and content.

Check if you need to do an update or
upgrade of your SAP Solution Manager
application or content.

After an upgrade or update to the latest
SAP Solution Manager release, you need to
do follow-up actions described in the
section Software Change Management of
the Solution Operations Guide.

See SAP Note 631042 for information
about the Release strategy for
Implementation Content (ST-ICO).

See SAP Note 781448 for information
about Support Package levels of
Solution Manager installations and
upgrades.

The Solution Operations Guide for
SAP Solution Manager is available at:
| service.sap.com/instguides »
Installation & Upgrade Guides » SAP
Components ¥ SAP Solution
Manager » <Release> » Operations 1.

2.2 Planning the Use Cases and their System Landscapes

In the following, you get information about the system landscapes for the different SAP NetWeaver uses cases

e Building Composite Applications [page 20]

® Building Integration Scenarios [page 25]

® Data Warehousing [page 32]

® Mobilizing Business Processes [page 34]

® |ntegrating and Self-Servicing Content with SAP NetWeaver Portal [page 35]

e SAP Knowledge Warehouse [page 36]

e Custom Application Development (ABAP) [page 37]

For some uses cases, you get some additional planning information.

= Recommendation

® For more details and aspects regarding the System Landscape Design and Infrastructure, we refer you to
the information about Landscape Design and Infrastructure that you can access from the document
Technical Enablement - Application Lifecycle Management in the Software Community Network (SCN).
Choose [» scn.sap.com/docs/DOC-23404 » Landscape Design and Infrastructure 3.

® See also the information about Preparing the System Landscape Directory (SLD) in the SAP NW74 Library,
available at [k help.sap.com/nw74 » System Administration and Maintenance Information » Technical
Operations for SAP NetWeaver » Section: Administration of SAP NetWeaver systems and components »
Technical Operations for SAP NetWeaver Development Infrastructure (DI) » Development Infrastructure
(DI) » Configuring the Development Infrastructure » Preparing the System Landscape Directory (SLD) 1.

® Furthermore, see the information about Managing System Landscape Information in the Help Library for

the Solution Manager.

Choose |r help.sap.com/solutionmanager71 » Application Help » SAP Library » SAP Solution Manager
Operations » Managing System Landscape Information 3.

SAP NetWeaver 7.4 incl. SR1
Planning SAP NetWeaver 7.4

CUSTOMER
© Copyright 2014 SAP AG.
All rights reserved. 19


http://service.sap.com/~form/handler?_APP=01100107900000000342&_EVENT=REDIR&_NNUM=631042&_NLANG=en&_NVERS=0
http://service.sap.com/~form/handler?_APP=01100107900000000342&_EVENT=REDIR&_NNUM=781448&_NLANG=en&_NVERS=0
http://service.sap.com/instguides
http://scn.sap.com/docs/DOC-23404
http://help.sap.com/nw74
http://help.sap.com/solutionmanager71

2.2.1 Building Composite Applications

SAP NetWeaver Composition Environment provides design time and runtime infrastructures for developing,
running, and managing composite applications that comply with SAP Enterprise Service-Oriented Architecture
(enterprise SOA) technologies. Composite applications use this service-oriented architecture to fill the gaps that
standard solutions cannot cover.

With Process Orchestration, you can combine the process modeling, operation, and monitoring capabilities of
SAP NetWeaver Business Process Management (BPM) with the integration capabilities of SAP NetWeaver
Process Integration (Advanced Adapter Engine Extended (AEX) installation option). For more information, see
Process Orchestration [page 30].

2.211 System Landscape

In order to plan the system landscape for SAP NetWeaver Composition Environment (SAP NetWeaver CE) you
should start by answering the following questions:

e \Which back-end systems are required?

The answer to this question depends on the functions and data you would like to use to build your composite
applications, and whether you want to continue using existing software, such as the software lifecycle
management functions of your back-end system.

e Which central usage types of SAP NetWeaver can be shared when using SAP NetWeaver CE in combination
with SAP NetWeaver Portal or in combination with SAP NetWeaver Process Integration (SAP NetWeaver PI)?

The following graphic gives an overview of SAP NetWeaver CE in a system landscape using SAP NetWeaver
Process Integration, SAP NetWeaver Portals, and already existing back-end systems:
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Figure 1: SAP NetWeaver CE Combined with Other Use Cases and Back-End Systems
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The following sections give recommendations for possible shared usages or installation requirements in your
system landscape, for example, with respect to the following options shown in the graphic above:

® [Enterprise Services Repository can both be used for SAP NetWeaver CE and SAP NetWeaver PI. See section
Working with Enterprise Services Repository below for more details.

® The Composition Environment Platform contains the functional unit Portal that offers — apart from minor
exceptions — the same functionality as usage type EP Core — Application Portal for SAP NetWeaver Portal.
See section Working with SAP NetWeaver Portal below for more details.

Connecting to Back-End Systems

You can integrate and use a back-end system in the following scenarios:
® You access data residing on a back-end system.

You can reuse existing data in the composite applications. For example, if you want to use data residing in an
SAP ERP system, you can use the SOA capabilities (in SAP ERP 6.0 systems based on SAP NetWeaver 7.0
Support Package Stack 9 or higher) or you can connect using Remote Function Calls (RFC) to older systems
using the Java Connector (JCo) that is offered as a part of SAP NetWeaver AS Java.

® You use enterprise services on SAP or non-SAP back-end systems.

You can leverage the SOA capabilities of SAP NetWeaver by consuming services provided by an SAP back-
end system such as SAP ERP 6.0 (on SAP NetWeaver 7.0 SPS9 or higher), or the ES Workplace that you can
access using the SAP Community Network (SDN) at [F scn.sap.com/community/soa 3. Note that you can
use the ES Workplace in this context only to try some features out, it is not intended for productive use.

In addition, you can consume services from a third-party back-end system using the standard-based web
service capabilities of the stack. The SAP NetWeaver AS Java installation includes a Services Registry that
enables you to browse the registered service definitions.

Working with Enterprise Services Repository

As a prerequisite for using Enterprise Services Repository (ES Repository), the System Landscape Directory is
needed where products and software components are maintained. You can create your own products and
software component versions in the System Landscape Directory. Before the start of development, you need to
import the required software component versions from the System Landscape Directory into the ES Repository.

1 Note
Note that the following JAVA archives are installed among other software components as part of Enterprise
Services Repository:

® ChartDirector.jar

® Jjide.jar

We recommend using Enterprise Services Repository on the same AS Java where you use the Services Registry
for building composite applications.

If you use SAP NetWeaver systems for building composite applications and for building integration scenarios
(using SAP NetWeaver PI), we strongly recommend maintaining all your design objects in one ES Repository.

SAP NetWeaver Pl is tightly coupled with ES Repository and requires configuration to connect to a given ES
Repository. By default, Pl connects to the default ESR delivered with SAP NetWeaver PI, while you can use any ES
Repository for building composite applications. We recommend using the latest version of ESR in the landscape.

More information at: | help.sap.com/nw74 » Application Help » SAP NetWeaver Composition Environment »
Administrator's Guide » Configuring Composition Environment » Configuring Additional Components » Configuring
Enterprise Services Repository » Configuring a Central ES Repository in a CE and Pl Landscape 1.
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Working with SAP NetWeaver Portal
Integrating Applications into SAP NetWeaver Portal

Once you create and run your applications on the SAP NetWeaver CE system, you can use standard portal
capabilities for integrating Java applications into iViews.

® For back-end connectivity to SAP transaction and BEx Web iViews, use the portal system landscape
overview.

® Toenable back-end connectivity for other application types, such as composite views and processes, use
Remote Function Calls (RFCs) and Web services, which are configured in SAP NetWeaver Administrator.

For more information, see|r help.sap.com/nw74 » Application Help » SAP NetWeaver Composition
Environment » Administrator's Guide » Administering Composition Environment » Additional Administration
Tasks » Integrating Content into the SAP NetWeaver Portal CE 1.

Running Composite Applications in SAP NetWeaver Portal

Once you have integrated your composite applications into SAP NetWeaver Portal, the following scenarios have to
be distinguished:

® Running composite applications in a portal when developing and testing them in your landscape.

® Allowing business users to access composite applications in a productive environment.

Depending on the scenario, either usage type Composition Environment Platform (CEP) is sufficient or a local
Portal installation (usage types EPC — Applications Portal (EPC) and optionally Enterprise Portal (EP)), or a remote
SAP NetWeaver Portal installation is required. In the following table, the terms local and remote are to be
understood from the viewpoint of an SAP NetWeaver 7.4 installation:

Table 8

Developing and Testing Accessing Composite Applications in Productive
Environments

Product SAP NetWeaver 7.4 ®  SAP NetWeaver 7.0 3rd Party Solution

e  SAP NetWeaver 7.0
including enhancement
package 1l or 2

e  SAP NetWeaver 7.3

®  SAPenhancement
package 1 for
NetWeaver 7.3

®  or SAP NetWeaver 7.4

Required Usage Type CEP* EPC* (EP**) —

Type of Access Local Local (SAP NetWeaver 7.4) Remote
and remote (SAP NetWeaver
7.0, SAP NetWeaver 7.0
including enhancement
package 1 or 2, SAP
NetWeaver 7.3, SAP
enhancement package 1 for
NetWeaver 7.3, and SAP
NetWeaver 7.4)
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Developing and Testing Accessing Composite Applications in Productive
Environments

Additional Information

Note that the portal installed
with usage type Composition
Environment Platform can

You can enable the runtime
access of composite
applications from a remote

function as a producer portal | o
only; consumer capabilities

SAP NetWeaver 7.0

®  SAP NetWeaver 7.0

are therefore not supported.
rethe re not supporte including enhancement

package 1 or 2
e SAP NetWeaver 7.3

®  SAPenhancement
package 1 for
NetWeaver 7.3

® or SAP NetWeaver 7.4
portal, either by using the
SAP NetWeaver Portal iView
Wizard, or by settingup a
federated portal network.

* The installation of usage type EPC allows you — in addition to the functions provided by usage type Composition
Environment Platform — to enable the runtime access of composite applications in the portal on the local system
using GPAL and the iView wizards.

** Usage Type EP requires usage type EPC and extends the portal to a full Enterprise Portal. For more
information, see section System Landscape Aspects for Integrating and Self-Servicing Content with SAP
NetWeaver Portal [page 35].

For more information about enabling runtime access from a remote SAP NetWeaver 7.0, SAP NetWeaver 7.3; SAP
enhancement package 1 for NetWeaver 7.3, or SAP NetWeaver 7.4 portal, see |p help.sap.com/nw74 » Application
Help » SAP NetWeaver Composition Environment » Administrator's Guide » Administering Composition
Environment » Additional Administration Tasks » Running CE Applications in Remote Portals (Optional) 3.

2.21.2 Further Aspects for Your Installation Planning

Overview

The following graphic shows the software units that are used for Building Composite Applications:
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Figure 2: Software Units for Building Composite Applications

When setting up the system landscape, you need to consider the development environment for each developer
and the overall system landscape for developing, testing, and running composite applications.

We recommend using a combination of development system, test system, and production system with a central
AS Java to develop, consolidate, test, and run your application productively. This system landscape is also the
preferred option for developing a composite application in a team of developers.

In order to describe this scenario, the following sections focus on the AS Java and the Developer Studio, because
the installation is tailored to these main software units. Of course, additional usage types or clients need to be
installed in addition depending on your scenario.

For information about supported operating systems and databases, see the Product Availability Matrix for SAP
NetWeaver 7.4 available at service.sap.com/pam.

Planning Your Installation of SAP NetWeaver Development, Test, and Production Systems for
Composite Applications

When using SAP NetWeaver for development of composite applications aimed for productive use, we strongly
recommend setting up a system landscape consisting of the following systems:
® Development System and Test System
Use these systems for development and quality assurance.
®  Production System
Use this system to run your applications separately from your development and test landscape.

The system landscape supports consolidating and testing individual development and, as a consequence, is
strongly recommended for team development projects.

The following graphic provides an overview of the recommended system landscape:
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Figure 3: Recommended SAP NetWeaver system landscape

With respect to the installation of the development environment, you install a AS Java centrally and Developer
Studio instances on each developer host. This option requires fewer hardware resources per developer host. In
this landscape scenario you can set up an AS Java in development mode centrally and connect to it from the other
hosts in the landscape using the Developer Studio.

In a production system landscape, you have to install a central 64-bit SAP NetWeaver Application Server Java in
productive mode for running composite applications to address additional runtime requirements such as
clustering and higher default memory settings. We strongly recommend installing a central 64-bit server in
productive mode for both the test system landscape and the development system landscape as well.

SAP NetWeaver Application Server Java 7.4 SPO3 or higher based on SAP HANA
As of SAP NetWeaver 7.4 SP0O3, the SAP HANA database supports Application Server Java and further usage
types that are dependent on AS Java.

For more information in terms of the implementation of SAP NetWeaver Application Server Java 7.4 based on
SAP HANA database, see the End-to-End Implementation Roadmap for SAP NetWeaver AS Java based on SAP
HANA. This guide is available on the Service Marketplace at |F service.sap.com/installnw74 » Planning 3.

2.2.2 Building Integration Scenarios

You can either install SAP NetWeaver Process Integration (Pl) as a standard installation (dual-stack system) or
the Advanced Adapter Engine Extended (AEX), which is based on AS Java only. Both options are described in
System Landscape for Building Integration Scenarios [page 26].

Furthermore, you have the possibility to install the Process Integration and Orchestration Package [page 301].
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Caution
SAP NetWeaver discontinues Dual Stack deployments

SAP NetWeaver discontinues Dual Stack deployments as of release 7.4. No update or update of optional dual-
stack SAP NetWeaver systems is supported to SAP NetWeaver 7.4 and higher (and already as of SAP
NetWeaver 7.0 with SAP enhancement package 1, you can no longer install optional dual-stack application
systems). Also for earlier releases than SAP NetWeaver 7.4, SAP recommends to avoid optional dual-stack
deployments where possible.

The only exception to this rule is SAP NetWeaver Process Integration on a traditional database system, which
still requires a dual-stack implementation. However, note that a single-stack SAP NetWeaver Process
Integration Java (Advanced Adapter Engine Extended) exists that offers 95% of the features of classical dual-
stack implementations.

Therefore, you should investigate if a Java-only implementation of SAP NetWeaver Pl is a feasible approach for
your use cases. Due to the harmonized process orchestration stack (SAP NetWeaver Pl and SAP NetWeaver
BPM running on the same Java instance), many of the ccBPM features in SAP NetWeaver Pl can be expressed
using SAP NetWeaver BPM capabilities instead.

For more information, see the SAP Community Network at: [F scn.sap.com/docs/DOC-33703 1.
SAP Business Suite

The same applies for the SAP Business Suite: SAP Business Suite 7i2011, which is based on SAP NetWeaver
7.0 including Enhancement Package 3, is the last SAP Business Suite release with dual-stack support. No
upgrade or update of dual-stack SAP Business Suite systems is supported to higher releases — for more
information, see SAP Note 1816819. Already as of SAP Business Suite 7, you can no longer install dual-stack
application systems.

1 Note
SAP NetWeaver Application Server Java 7.4 SPO3 or higher based on SAP HANA

As of SAP NetWeaver 7.4 SP0O3, the SAP HANA database supports Application Server Java and further usage
types that are dependent on AS Java.

For more information in terms of the implementation of SAP NetWeaver Application Server Java 7.4 based on
SAP HANA database, see the End-to-End Implementation Roadmap for SAP NetWeaver AS Java based on SAP
HANA. This guide is available on the Service Marketplace at |» service.sap.com/installnw74 » Planning 1.

2.2.2.1 System Landscapes for Pl and AEX

The Pl standard installation (dual-stack) offers the complete functional range, whereas the functional range of
AEX is restricted, but has the advantage of a lower TCO.

The following figures depict both options:
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1 Note

When you choose the Process Integration installation option in the installation tool, all dependent usage types

are selected and installed automatically.
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When you plan your system landscape for building integration scenarios, consider the following aspects:

® |tis mandatory to have a dedicated Pl system. This applies to development, quality, and production
landscapes.

For PI, it is a prerequisite that no other system in your system landscape has a higher release than the PI
system. For exceptions to this rule, see SAP Note 1043047. For example, SAP XI 3.0 is compatible with SAP
NetWeaver 6.40 and 7.0 application systems since the same Xl protocol is used. Apart from these
exceptions, if you want to upgrade or install an application in your system landscape, you first have to make
sure that the Pl system is on the same release level. If required, you have to upgrade the Pl system first to the
new or a higher release.

Caution

Although it should be technically possible to run an application system with a higher release than your PI
system in your system landscape, this is not supported by SAP (apart from the exceptions listed in SAP
Note 1043047). Therefore, you run such a landscape at your own risk.

® Youcan use the Advanced Adapter Engine that is part of your Pl system as a central Advanced Adapter
Engine. You can optionally deploy additional non-central Advanced Adapter Engines.

Adapter Engine (Java SE) can be installed in a non-SAP Java environment. However, it only hosts a subset of
the adapter functionality, is only supported for compatibility reasons, and should be used only if this is a
precondition in your environment. The following table shows the characteristics of the central Advanced
Adapter Engine, the non-central Advanced Adapter Engine, and the Adapter Engine (Java SE) as an overview:
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Table 9

Installation Option Characteristics

Central Advanced Adapter Engine on the Pl host

No additional installation procedure required
Suitable for development or test scenarios

Data source (file, database, JMS provider) must be
accessible using NFS, tcp-ports, and so on (may only
be available in homogeneous LAN environments).

Possible performance bottleneck due to high RAM
needs. The system needs three times the amount of
the maximum message size as RAM, for example.

Non-central Advanced Adapter Engine

Provides complete integration into the PI
environment:

o Central Monitoring available
o Central Configuration available

More resources needed for installing the SAP
NetWeaver Java system

Adapter Engine (Java SE)

Installation possible on non-released SAP NetWeaver
platforms

Only HTTP connection required between adapter
engine and Integration Server. Suitable for a more
heterogeneous system landscape with mixed
operating systems and authorization concepts, or for
distributed WAN environments with firewalls, and so
on.

Fewer resources needed when running in a Java
environment only

Additional installation procedure required for JDK
and the adapter itself

Poorer integration with the SAP NetWeaver Process
Integration environment due to lack of central

configuration and monitoring services

® You can install an Advanced Adapter Engine Extended (AEX). This provides tools for designing and
configuring integration content (Enterprise Services Repository, Integration Directory and System
Landscape Directory), as well as the Advanced Adapter Engine as a runtime engine. This installation option is
based on AS Java only and you can use it without a standard Process Integration system. You can optionally

deploy additional non-central Advanced Adapter Engines.

1 Note

Regarding the deployment of any other usage type besides Business Process Management (BPM) on an
existing Advanced Adapter Engine Extended (AEX), see SAP Note 1868764.

The following table compares the Advanced Adapter Engine Extended to an SAP NetWeaver Process

Integration standard installation:
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Table 10
Installation Option Advantage Disadvantage
Advanced Adapter Engine Extended ® [Easytoinstall and to maintain ®  Connectivity options restricted
(Javaonly) to adapters of AAE
®  Fewer resources needed ® |ntegration processes not
available
®  Only process integration
scenarios available as ESR
modeling option
SAP NetWeaver Process Integration ®  Complete functional range of ® More memory and data storage
SAP NetWeaver Process required
Integration ®  More cost-intensive
1 Note

User Management

o If you deploy non-central Advanced Adapter Engines with Advanced Adapter Engine Extended
(AEX), use the Local User Management (UME Configuration "Java Database") on the non-central
Advanced Adapter Engines. At runtime the non-central Advanced Adapter Engines work
independently of the AEX.

o If you deploy non-central Advanced Adapter Engines with PI, use the ABAP User Management on the
Pl system.

e The AS ABAP system acts as an application and service provider. For Java Web Services, you also require AS
Java. In addition, you require SAP NetWeaver Developer Studio on the client side as a development
environment.

The Web service client can be either an SAP or a non-SAP application. For example, an AS ABAP system or a
Web browser could act as an application or service consumer.

More Information

See the Help Portal at:
® |» help.sap.com/nw74 » Application Help » SAP NetWeaver Process Integration 3
for more information about the concepts and capabilities of SAP NetWeaver Process Integration (PI).

® |p help.sap.com/nw74 » Application Help » Function-Oriented View » Process Integration » Configuring
Process Integration After Installation 2

for more information about the deployment and the configuration.

2.2.2.2 Process Orchestration

Process Orchestration provides a tool infrastructure to model and design business processes — from the overall
process flow and the sequence of activities up to the interfaces and data types that are needed to integrate SAP
systems and external systems. It combines the integration capabilities of SAP NetWeaver Process Integration
(Advanced Adapter Engine Extended (AEX) installation option) with the process modeling, operation, and
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monitoring capabilities of SAP NetWeaver Business Process Management (BPM). Like AEX, Process
Orchestration is based on AS Java only.

Integration

The package is based on the following components:
e Components of the Advanced Adapter Engine Extended (AEX), in particular:
©  Enterprise Services Repository
Enables you to design integration content like service interfaces and mappings, for example.
o Integration Directory

Configuration tool that allows an integration expert to configure integration content, in particular: One
the one hand, to specify the business communication between business systems and Process
Orchestration and, on the other hand, to specify the connectivity between the BPM process and the
Process Integration runtime.

©  Advanced Adapter Engine
Process Integration runtime component that allows you to process XML messages.
® Business Process Management and Business Rules Management engines

Allows an integration expert to model business processes and to execute and monitor the business
processes (BPM-based applications) at runtime.

The involved components are illustrated in the figure below.
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Figure 6: Components of Process Orchestration
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1 Note

You can obtain Process Orchestration by installation or by adding the corresponding usage types to an existing
SAP NetWeaver system. For latter, both are supported, deployment of BPM on an existing AEX system and
deployment of an AEX on an existing BPM system.

Regarding the deployment of additional usage types besides BPM and AEX, see SAP Note 1868764. You can
deploy non-central Advanced Adapter Engines with Process Orchestration.

Constraints

® Process Orchestration runs on one system. The deployment on more than one system is not supported.

® Process Orchestration can be installed in a cluster. Every node would have an AEX and a BPM instance
running

More Information

See the Help Portal at:
® |p help.sap.com/nw74 » Application Help » Function-Oriented View » Process Orchestrat